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AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

About this Document
This manual is intended for administrators and users of the 
AXIS 210A/211A Network Camera and applies to firmware 
release 4.47. It includes instructions for using and managing 
the AXIS 210A/211A on your network. Previous experience 
of networking will be of use when using this product. Some 
knowledge of UNIX or Linux-based systems may also be 
beneficial, for developing shell scripts and applications. Later 
versions of this document will be posted to the Axis Website, 
as required. See also the product’s online help, available via 
the Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the 
product.
Important! - Indicates a hazard that can seriously impair 
operation. 
Do not proceed beyond any of the above notices until you 
have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one or 
more additional patents or pending patent applications in the 
US and other countries. 

This product contains licensed third-party software. See the 
menu item “About” in the product’s user interface for more 
information.

This product contains source code copyright Apple Computer, 
Inc., under the terms of Apple Public Source License 2.0 (see 
http://www.opensource.apple.com/apsl/).  
The source code is available from: 
http://developer.apple.com/darwin/projects/bonjour/

Legal Considerations
Video and audio surveillance can be prohibited by laws that 
vary from country to country. Check the laws in your local 
region before using this product for surveillance purposes.
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.
Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 
Re-orient or relocate the receiving antenna. Increase the 
separation between the equipment and receiver. Connect the 
equipment to an outlet on a different circuit to the receiver. 
Consult your dealer or an experienced radio/TV technician 
for help. Shielded (STP) network cables must be used with 
this unit to ensure compliance with EMC standards.

USA - This equipment has been tested and found to comply 
with the limits for a Class B computing device pursuant to 
Subpart B of Part 15 of FCC rules, which are designed to 
provide reasonable protection against such interference when 
operated in a commercial environment. Operation of this 
equipment in a residential area is likely to cause interference, 
in which case the user at his/her own expense will be 
required to take whatever measures may be required to 
correct the interference. 

Europe -  This digital equipment fulfills the 
requirements for radiated emission according to limit B of 
EN55022/1998, and the requirements for immunity according to 
EN55024/1998 residential, commercial, and light industry.

Japan - This is a class B product based on the standard of the 
Voluntary Control Council for Interference from Information 
Technology Equipment (VCCI:2003 Class B ITE). If this is used 
near a radio or television receiver in a domestic environment, it 
may cause radio interference. Install and use the equipment 
according to the instruction manual. 

Australia - This electronic device meets the requirements of the 
Radio communications (Electromagnetic Compatibility) Standard 
1998 AS/NZS 3548.

Canada - This Class B digital apparatus complies with Canadian 
ICES-003 B by compliance with EN55022: Class B.

Liability
Every care has been taken in the preparation of this manual. 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right to 
make changes to the product and manuals without prior notice. 
Axis Communications AB makes no warranty of any kind with 
regard to the material contained within this document, including, 
but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Axis Communications AB shall 
not be liable nor responsible for incidental or consequential 
damages in connection with the furnishing, performance or use of 
this material.

Trademark Acknowledgments
Boa, Ethernet, Internet Explorer, Linux, Microsoft, Mozilla, 
Netscape Navigator, OS/2, UNIX, Windows, WWW are registered 
trademarks of the respective holders. Java and all Java-based 
trademarks and logos are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the United States and other countries. 
Axis Communications AB is independent of Sun Microsystems 
Inc. UPnPTM is a certification mark of the UPnPTM Implementers 
Corporation. 

Support
Should you require any technical assistance, please contact your 
Axis reseller. If your questions cannot be answered immediately, 
your reseller will forward your queries through the appropriate 
channels to ensure a rapid response. If you are connected to the 
Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. Search 

by product, category, or phrases
• report problems to Axis support by logging in to your private 

support area
• visit Axis Support at www.axis.com/techsup/

Safety Notice - Battery Replacement
The AXIS 210A/211A uses a 3.0V CR2032 Lithium battery as the 
power supply for its internal real-time clock (RTC). Under normal 
conditions this battery will last for a minimum of 5 years. Low 
battery power affects the operation of the RTC, causing it to reset 
at every power-up. A log message will appear when the battery 
needs replacing. The battery should not be replaced unless 
required!
If the battery does need replacing, please observe the following:
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 

recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 

instructions.

AXIS 210A/211A User’s Manual 
Revision 3.0, Part No: 32532, July 2008                     
Copyright© Axis Communications AB, 2007-2008
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Introduction
This manual covers the following Axis Network Camera models:

• AXIS 210A 
• AXIS 211A 

All instructions and information in this manual are valid for both models unless otherwise 
stated.

Product features
The AXIS 210A/211A cameras are based on the AXIS ARTPEC-2 compression chip. Both 
models support the following features:

• Video streams from the camera available on the network as real-time, full frame 
rate, Motion JPEG and/or MPEG-4 video streams. 

• Video Motion Detection - this can be used to trigger image uploads when there is 
activity in the video image. 

• Scheduled image uploads. 
• IP address filtering and multi-level password protection.
• Alarm input and output, which can be connected to various external devices, 

such as door sensors and alarm bells. 
• Multiple video resolutions. 
• Simultaneous access by up to 20 viewers when using Motion JPEG. If MPEG-4 

multicast is used, the number of viewers is unlimited, but each viewer still needs a 
separate MPEG-4 license. One license is included in the product, additional 
licenses can be purchased separately.

• Privacy masking allows the concealment of parts of the image that should not be 
viewable. Up to three areas can be configured as masked areas. 

• Built-in web server that provides full access to all features via a standard web 
browser.

• Built-in scripting tool that allows the creation of basic applications. For advanced 
functionality, the cameras can be accessed via VAPIX®, Axis Communications’ 
powerful API (more info at www.axis.com/developer).

AXIS 210A AXIS 211A
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• (PoE) Power over Ethernet - supporting PoE network transformers conforming to 
IEEE 802.3af, the camera can be powered directly from the network cabling. 

• Two-way audio - two-way audio capability for up to 20 simultaneous users. 
Audio communication can be bi-directional (full-duplex), push to talk 
(half-duplex) or in one direction only (simplex).  
The AXIS 210A/211A has an integrated mono microphone, but there is also an 
audio input for connecting an external microphone or other source producing a 
line level signal. An active speaker with a built-in amplifier can be connected to 
the audio output to enable two-way communication.

• SNMP - the Simple Network Management Protocol allows the remote manage-
ment of network devices.

• HTTPS - the AXIS 210A/211A supports encrypted browsing using HTTPS. 

Extra features - AXIS 211A

DC-Iris

The AXIS 211A features a varifocal DC-Iris, which automatically regulates the amount of 
light entering the camera. Tele/wide and focus are adjusted manually with the aid of the 
pullers mounted on the lens.
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Overview
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Power Connector - For connection of the PS-K power adapter (included).

I/O Terminal Connector - The I/O terminal connector provides the physical interface to 
one transistor output, one digital input and an auxiliary connection point for DC power. 
For more information, see The I/O Terminal Connector, on page 55.

Note: Depending on the product version of your AXIS 210A/211A, you will see one of two different types of I/O 
terminal connectors. See The I/O Terminal Connector, on page 55.

Network Connector - The camera connects to the network via a standard network 
connector. The camera detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet). This socket can also be used to power the AXIS 210A and 
the AXIS 211/211A via PoE (Power over Ethernet). 

Audio Output - Audio output (line level), which can be connected to a public address (PA) 
system or an active speaker with a built-in amplifier. A pair of headphones can also be 
attached. A stereo connector must be used for the audio out.

External Microphone/Line Input - One 3.5mm input for a mono microphone, or for 
line-in mono signal (only the left channel is used from a stereo signal).

Serial Number - This number is used during installation. 

Control Button - Press this button to install using the AXIS Internet Dynamic DNS Service 
(see page 46) or to restore the factory default settings, as described in Resetting to Factory 
Default Settings, on page 53.

LED Indicators

After completion of the startup and self test routines, the multi-colored Network, Status, 
and Power LED indicators show as follows:

Network Amber Steady for connection to 10 Mbit/s network. Flashes for network activity.

Green Steady for connection to100 Mbit/s network. Flashes for network activity.

Unlit No wired network connection.

Status
Green Shows steady green for normal operation. Can be configured to flash green at intervals 

whenever the camera is accessed. 

Unlit When configured for “no flash” on camera access. 

Amber Steady during startup, reset to factory default or when restoring settings.

Red Slow flash for failed firmware upgrade.

Power Green Normal operation.

Amber Flashes green/amber during firmware upgrade.
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Accessing the Camera
Follow the instructions in the AXIS 210A/211A Installation Guide to install your camera. 

The cameras can be accessed with most standard operating systems and browsers. The 
recommended browser is Internet Explorer for Windows, and Firefox with other operating 
systems. See also the Technical Specifications, on page 57.

Note: To view streaming video in Microsoft Internet Explorer for Windows, you may set your browser to allow the 
AXIS Media Control (AMC) to be installed on your computer. The first time an MPEG-4 video stream is 
accessed AMC also installs an MPEG-4 decoder for viewing the video streams. As a license is required for 
each instance of the decoder, the product administrator may have disabled the installation. If your com-
puter restricts the use of additional software components, the cameras can be configured to use a Java 

applet for updating JPEG images. See the online help for more information.

Accessing From a Browser
1. Start a browser (Internet Explorer, Firefox)

2. Enter the IP address or host name 
of the cameras in the 
Location/Address field of your 
browser.

3. If you are accessing the camera for 
the first time, see Setting the root password, on page 10. Otherwise enter your user 
name and password, as set by the administrator. 

4. The camera’s Live View is now displayed in your browser. 

Note: The layout of the live view in the cameras may be customized to meet specific requirements. Some of the 
examples and functions featured here may differ from those displayed on your own Live View page.



 10 AXIS 210A/211A - Accessing the Camera
Setting the root password
1. When accessing a camera for the first time, the ‘Configure Root Password’ dialog is 

displayed on the screen.

Note: Before you enter your password at this point, you can secure configuration of the root password via HTTPS 
by creating a self-signed certificate. To do so, click the Create self-signed certificate... button in the Cre-
ate Certificate window, and then proceed as follows.

2. Enter a password, and re-enter to confirm the spelling. Click OK.

3. The ‘Enter Network Password’ dialog appears. Enter the User name: root

Note: The default administrator user name root is permanent and cannot be deleted.

4. Enter the password as set in step 2 above, and click OK. If the password is lost, the 
cameras must be reset to the factory default settings. See page 53.

5. If required, click Yes to install the AXIS Media Control (AMC). You will need 
administrator rights on the computer to do this.

Accessing from the Internet
Once installed, a camera is accessible on your local network (LAN). To access the camera from the Internet you must 
configure your broadband router to allow incoming data traffic. For security reasons this is usually done on a specific 
port. Please refer to the documentation for your broadband router for further instructions.

For more information, please visit the AXIS Internet Dynamic DNS Service at www.axiscam.net or, for Technical notes 
on this and other topics, visit the Axis Support Web at www.axis.com/techsup
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Focusing

To focus the AXIS 210A

Unscrew the focus puller on the lens. 
Adjust the focus as required. Re-tighten the 
focus puller.

To focus the AXIS 211A

Follow the instructions below. 

1. From the Basic Configuration page 
in your browser, open the Focus 
adjustment page.

2. Set the DC-Iris to Disabled and click 
Save.

3. Unscrew the zoom puller on the lens 
by turning it anti-clockwise. Adjust 
the zoom setting as required. 
Re-tighten the zoom puller.

4. Unscrew the focus puller on the lens. Adjust the focus as required. Re-tighten.

5. From the Focus adjustment page, set the DC-Iris to Enabled and click Save.

Note: The DC-Iris should always be disabled while focusing the camera. This opens the iris to its maximum, which 
gives the smallest depth of field and thus the best conditions for correct focusing. When the focus is set 
with this method it is maintained in any light condition.

AXIS 210A

Focus puller

AXIS 211A

Focus puller

Zoom puller
(Tele/wide)
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The Live View Page
You may not view all the buttons described below if the Live View page has been 
customized.

The Video Format drop-down list allows the video format on the Live View 
page to be temporarily changed. 

These buttons start and stop the Sequence Mode. This mode is created in 
Setup > Live View Config > Sequence mode, and automatically displays the 
view from two or more video sources at set intervals.

From the Source list, select the desired external video source. Note 
that Sequence Mode must be stopped before selecting a source from 
this list.

The Action buttons can trigger an event directly from the Live View page. 
These are configured under Setup > Live View Config > Layout.

The Snapshot button saves a snapshot of the video image currently displayed. 
Right-click on the video image to save it in JPEG format on your computer. 
This button is primarily intended for use when the AMC viewer toolbar is not 
available.

The Output buttons control the 
output directly from the Live 
View page. These buttons are 
configured under Setup > Live 
View Config > Layout.

Pulse - click this button to activate the 
output for a defined period of time, e.g. 
switch on a light for 20 seconds.

Active/Inactive - click these buttons to 
manually start and stop a connected 
device, e.g. switch a light on/off.
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Audio controls for AXIS 210A/211A

There are also controls for controlling the client computer’s speaker output and 
microphone sensitivity. These controls are only available when audio is enabled, see  
Audio Settings, on page 26. Push-to-talk settings are made in the AMC control panel, see  
AXIS Media Control, on page 16. 

The Live View toolbar displays the following buttons:

The Play/Stop button starts and stops the live video stream.

The Snapshot button saves a snapshot of the video image displayed. The Snapshot 
function and the target directory for saving snapshots can be configured from the 
AMC Control Applet in the Windows Control Panel (Internet Explorer for 
Windows only). See  AXIS Media Control, on page 16.
Click the View Full Screen button to make the video image fill the entire screen 
area. Press Esc (Escape) on the computer keyboard to exit full screen, or 
right-click and select the option. 
The record button is used to record the current video stream. The location where 
the image file is saved can be specified using the AMC control panel. To enable 
recording, Select Live View Config > Viewer Settings > Enable recording 
button.

Click the Speaker and Microphone buttons to switch the sound off and on for 
the speaker and microphone, respectively.  

Use the sliders to control the volume on the speaker and 
microphone. The volume can be set between 0 and 100. The buffer 
slider controls the size of the buffer for audio. A higher level will 
reduce audio break-up, but may introduce a noticeable lag in 
audio transmission. There are four settings - min, low, high, and 
max. 

When using Half-duplex mode, this button toggles between allowing you to 
speak and listen. The first icon indicates that you can talk and the speaker 
attached to the camera will play your voice. The second indicates that you 
hear audio from the camera, but no audio is sent to any web clients.  

 
When in simplex talk mode, the icon allows you to speak and is dimmed when you 
do not want other clients to receive any audio.
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Video Streams
The AXIS 210A/211A provides several different image and video formats. You choose the 
type depending on your requirements and the properties of your network. 

The Live View page in the AXIS 210A/211A provides access to Motion JPEG and MPEG-4 
video streams, and to single JPEG images. Other applications and clients can also access 
these video streams/images directly, without going via the Live View page. 

Video Stream Types

Motion JPEG

This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated to create a stream that shows constantly updated motion. 

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides 
excellent image quality and access to every individual image contained in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4

This is a video compression standard that makes good use of bandwidth, and which can 
provide high-quality video streams at less than 1 Mbit/s. 

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 210A/211A provides certain 
subsets of these tools. These are represented as Video object types, which are selected for 
use with different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263, as used by QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC 

(AXIS Media Control). 
When using MPEG-4 it is also possible to control the bit rate, which in turn allows control 
of bandwidth usage. CBR (Constant Bit Rate) is used to achieve a specific bit rate by 
varying the quality of the MPEG-4 stream. When using VBR (Variable Bit Rate), the quality 
of the video stream is kept as constant as possible, at the cost of a varying bit rate. 

Notes: MPEG-4 is licensed technology. The AXIS 210A/211A includes one viewing client license. Installing addi-
tional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact your 
Axis reseller.

All clients viewing the MPEG-4 stream must use the same set of coding tools.
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage 
the real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate 
which transport protocol to use for the stream. RTSP is thus used by a viewing 
client to start a unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited 
service for exchanging data in a network that uses the Internet Protocol (IP). UDP 
is an alternative to the Transmission Control Protocol (TCP). The advantage of 
UDP is that it is not required to deliver all data and may drop network packets 
when there is network congestion. This is suitable for live video, as there is no 
point in re-transmitting old information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a 
network. The video stream goes independently to each user and each user gets 
their own stream. With unicasting that if one stream fails, it only affects one user.

• Multicast is bandwidth - conserving technology that reduces bandwidth usage by 
simultaneously delivering a single stream of information to multiple network 
recipients. This technology is used primarily on delimited networks (intranets), as 
users need uninterrupted data flow and should not rely on network routers.

How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network. Setting the preferred method(s) is 
done in the control applet for AMC, which is found in the Windows Control Panel. When 
this has been set, AMC will test all the selected methods in the specified order, until the 
first functioning one is found.

RTP+RTSP 

This method (actually RTP over UDP and RTSP over TCP) should be your first consideration 
for live video, especially when it is important to always have an up-to-date video stream, 
even if some images do get dropped. This can be configured as multicast or unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over the Internet. 

Unicasting should be used for video-on-demand broadcasting, so that there is no video 
traffic on the network until a client connects and requests the stream. However, as more 
unicast clients connect, the traffic on the network will increase and may cause congestion. 
Although there is a maximum of 20 unicast viewers, note that all multicast users combined 
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count as 1 unicast viewer.

RTP/RTSP

This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS

These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

AXIS Media Control 
The recommended method of accessing live video from the AXIS 210A/211A is to use the 
AXIS Media Control (AMC) in Microsoft Internet Explorer for Windows. This ActiveX 
component is automatically installed on first use, after which it can be configured by 
opening the AMC Control Panel applet from the Windows Control Panel. Alternatively, 
right-click the video image in Internet Explorer.

Other methods of accessing the video stream
Video/images from the AXIS 210A/211A can also be accessed in the following ways:

• If supported by the client, the AXIS 210A/211A can use Motion JPEG server push 
to display video. This option maintains an open HTTP connection to the browser 
and sends data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter the path:
http://<IP address>/axis-cgi/jpg/image.cgi?resolution=320x240

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be 
installed. The paths that can be used are listed below in the order of preference.

• Unicast via RTP: axrtpu://<IP address>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<IP address>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<IP 

address>/mpeg4/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<IP 

address>/mpeg4/media.amp 
• Multicast:  axrtpm://<IP address>/mpeg4/media.amp

Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, this is not 
guaranteed by Axis. For some other clients, such as QuickTime™ the Video Object Type 
must be set to Simple. It may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from QuickTime™ the following path can be used:
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rtsp://<IP address>/mpeg4/media.amp 

This path is for all supported methods, and the client negotiates with the AXIS 210A/211A 
to determine exactly which transport protocol to use.

Audio Stream Types
The stream types for audio are: 

• G.711 - International standard for encoding wired-telephone audio. Uses PCM 
samples to compress audio where higher signal values are compressed more than 
lower values. In Axis products, this sets the coding type to μ-law 64 kbit/s.

• G.726 - Uses PCM samples to code the difference between samples (ADPCM). 
Reduces bandwidth without losing too much useful audio. In Axis products, this 
sets the coded bit rate to 24 or 32 kbit/s.

All stream types are ITU-T standards and operate on frequencies up to 4 kHz.

Audio transmission methods

The audio stream can be accessed in the Live View page via Motion JPEG or MPEG-4. 

Using Motion JPEG

The basic audio transmission method used in conjunction with Motion JPEG video 
streaming is transmission over HTTP. The video and audio streams are not synchronized 
when using Motion JPEG, so the streams may be slightly out of sync. The latency in any 
stream should be low, but this depends on the network infrastructure.

Using MPEG-4

When using MPEG-4, audio is streamed using the same protocol as the video stream. When 
audio is transmitted using MPEG-4, the AXIS 210A/211A sends synchronization 
information along with the streams to the client performing the synchronization. 

Note: Audio is streamed from the client to the server over HTTP when using Motion JPEG and MPEG-4.

Accessing the Audio Streams
In addition to accessing audio in the Live View page using AMC, audio from the AXIS 
210A/211A can also be accessed in the following ways:

HTTP API

You can read about accessing audio for the other protocols through the VAPIX Application 
Programming Interface (API) at http://www.axis.com/techsup

QuickTime/Windows Media Player

It is possible to use QuickTime and Windows Media Player to listen to the audio stream 
using the same methods to access video streams.
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The Setup link
This section describes how to configure the cameras, and is intended for product 
Administrators, who have unrestricted access to all options in the web interface, and 
Operators who have access to the settings for Video & Image, Audio, Live View Config and 
Event Configuration.

The camera is configured under Setup from a standard browser (see).

Accessing the Setup link

Follow the instructions below to access the Setup link from a browser.

1. Start your browser and enter 
the IP address or host name 
of the cameras in the 
location/address field.

2. The Live View page appears. Click Setup to display the Setup link.

Setup link
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Video & Image settings
Given below are examples of features available in the AXIS 210A/211A. For details of 
each setting, please refer to the online help available from the web interface. Click  to 
access the online help.

Image Settings

Image Appearance

Adjust these settings to optimize the video images according to your requirements.

All configuration of images and overlays affect the camera’s overall performance, 
depending on how it is used and depending on the available bandwidth. Lower 
compression improves video image quality, but increases the bandwidth. 

The image can be rotated, and adjusted in terms of resolution and compression. The image 
can also be mirrored; the white balance can be changed. Please see the online help for 
further information on these settings. 

Changes made to video image settings have immediate effect on the MPEG-4 stream; the 
Motion JPEG stream must be restarted before the settings take effect.
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Text Overlay Settings

Include date, time and/or text of your choice to be viewed on the image. The color of the 
text may be set to white or black, while background color may be set to white, black, 
transparent or semitransparent. The position of the text is set either to the top or the 
bottom of the image. Click for more information.

Video Stream

Define the maximum video stream time per session in seconds, minutes or hours. When 
the set time has expired, a new stream can be started by refreshing the page in the Web 
browser. For unlimited video stream time, set this value to 0. This setting is only applicable 
to Motion JPEG.

The frame rate allowed to each viewer can also be limited, to avoid bandwidth problems 
on the network. 

Test 

To preview the image before saving, click Test. Note that the preview image is in JPEG 
format, even though the settings are valid both for Motion JPEG and MPEG-4.

Overlay/Mask Settings

Overlay/Mask Type

When using an image overlay, 
select from the following 
options: 

• Uploaded image as overlay - 
usually used to provide extra 
information in the video 
image. 

• Configurable areas as privacy 
masks - up to three areas are 
used to conceal parts of the 
video image.

The difference between an overlay and a privacy mask is that a privacy mask cannot be 
bypassed by accessing the video stream with the help of the AXIS HTTP API, whereas an 
overlay can.

Selecting the overlay/mask type displays further settings available for the selected type. 
See the online help for further information.

Overlay image

Text, date and 
time overlays



 22 AXIS 210A/211A - Video & Image settings
To upload and use an overlay

To upload an overlay image to the camera:

1. Select Uploaded image as overlay in the drop-down list for Overlay/Mask Type. 
New options appear.

2. Click the Browse button against Upload own image, and locate the image file on 
your computer or server. 

3. Click the Upload button and follow the on-screen instructions.

To use an uploaded image

1. Select an uploaded image from the Use image drop-down list.

2. Place the image at the required location by entering the x and y coordinates.

3. Click Save.

Overlay image requirements

There are a number of limitations when using overlay images, such as the size and 
positioning of images. Please refer to the online help for more information.

Configure area as privacy mask

The three configurable areas available for use as privacy masks show as solid areas of color 
in the image. These areas cannot be bypassed via VAPIX, Axis Communications’ powerful 
API. 

Enable the area(s) by checking the Enable box, and then set the width, height and color. 
Setting the coordinates x and y sets the position of the upper left corner of the area. 

Advanced Settings
These settings help to fine-tune the video image. Note that the advanced settings available 
depend on the camera model.

Lighting Conditions

Color level, Brightness and Contrast - find the level that best suits your image needs by 
testing.

Exposure control - this setting is used to adapt to the amount/type of light being used.

Image Formats Image Size
• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

The height and width of the overlay image in 
pixels must be exactly divisible by 4.
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Camera Settings

Low Light Behavior

Low light conditions can reduce image quality and increase bandwidth usage. The Low 
Light Behavior settings define the balance between image quality and frame rate. During 
low light conditions, experiment with the Priority, Max exposure time, and Max gain 
settings until you achieve an acceptable image quality at the required frame rate.

Priority defines the balance between image quality and the frame rate. Higher image 
quality may reduce frame rate and increase motion blur. A prioritized frame rate may 
increase image noise.

Increasing the Max exposure time increases the quality of the image, but decreases the 
frame rate. There may also be increased motion blur.

Max gain, measured in decibels (dB), describes the amount of amplification applied to the 
visual information in the image. A high level of amplification provides viewable images in 
very low light, but increases image noise.

To prioritize image quality, choose Prioritize image quality from the Exposure priority 
drop-down box, and lower the Max gain. If this does not produce the desired results, 
increase the Max exposure time.

To instead prioritize frame rate, choose Prioritize framerate from the Priority drop-down 
box and reduce the Max exposure time. The image darkens considerably, but the frame 
rate is maintained. To increase image brightness increase Max gain, but this increases 
image noise.

Please refer to the online help for more information.
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MPEG-4 Settings

Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different tools for various applications in different 
situations. As most MPEG-4 clients do not support all of these tools, it is usual to instead 
define and use subsets for different clients or groups of clients. These settings allow you to 
define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to a variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream. For more information on 
these advanced settings, please see Video Streams, on page 14, and the online help .

MJPEG

Sometimes the image size is large due to low light or complex scenery. Adjusting the 
maximum frame size helps to control the bandwidth and storage used by the MJPEG video 
stream in these situations. Defining the frame size as Unlimited provides consistently good 
image quality at the expense of increased bandwidth and storage usage during low light. 
Limiting the frame size optimizes bandwidth and storage usage, but gives poor image 
quality. To prevent increased bandwidth and storage usage, the maximum frame size 
should be set to an optimal value.

AXIS Media Control

The AXIS Media Control (AMC) is installed automatically the first time the camera is 
accessed from a browser. The AMC control panel can be opened by right-clicking on the 
video image in the Live View web page. The AMC control panel can be used to configure 
various network, video and audio settings such as:
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• Network reconnection strategy, multicast network interface, and MPEG-4 connec-
tion order

• MPEG-2 and MPEG-4 video processing settings and default video decoder setting
• Audio start settings and talk button options
• Video snapshot and recording settings
• Pan Tilt Zoom (PTZ) settings such as joy stick settings and PTZ mode settings

For more information, please see the AMC readme file included with AMC, or the Axis 
Media Control (AMC) User Manual available at www.axis.com 
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Audio
The AXIS 210A/211A can transmit audio to other clients using an external microphone 
and can play audio received from other clients by attaching a speaker. The Setup page for 
the AXIS 210A/211A has an additional menu item called Audio, which allows different 
audio configurations to be set up, such as full duplex, half duplex and simplex.

Note: The speaker attached to the audio output of the AXIS 210A/211A must have a built-in amplifier, such as PC 
speakers.

An example of a network using AXIS 210A/211A cameras to transmit audio and video across the network. 

Audio Settings
This section describes how to configure basic audio settings for the AXIS 210A/211A, e.g. 
set the communication mode and adjust the sound levels in the microphone and speaker 
connected to the camera. 

Enable Audio

Check this box to enable audio in the AXIS 210A/211A.

Audio Channels

There are two mono audio channels between the AXIS 210A/211A and other clients, one 
for receiving audio and one for transmitting audio. Each audio channel can be turned on 
or off, which means that there are four audio mode options that can be used.

TCP/IP Network

AXIS 210A/211A

Client PC

AXIS 210A/211A
AXIS 210A/211A
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Full-duplex mode means you can transmit and receive audio (talk and listen) at the same 
time, without having to use any of the controls. This is just like having a telephone 
conversation. The only controls you may wish to use are the mute buttons to turn off the 
sound, and the sliders, to adjust the input/output volume levels. This mode requires the 
client PC to have a sound card with full-duplex audio support. If your available bandwidth 
is 0.2 Mbit/s or less, using Half-duplex mode is recommended instead.

Half-duplex mode also transmits and receives audio in both directions, but only in one 
direction at a time. This means that you must select when to receive or transmit audio with 
the help of the push-to-talk button. To speak, press and hold the button (check that the 
microphone is not muted). When finished, release the button. You will now receive audio 
from the other end of the connection. 

When using half-duplex, the Send the sound from the active client to all other clients 
option transmits the audio signal from the client that is talking to all the other clients.

Note that the push-to-talk button is configured from AMC; see AXIS Media Control, on 
page 24. It is also possible to configure the push-to-talk button so that it toggles between 
the speaking and listening modes. Half-Duplex mode is best if you only have limited 
bandwidth available.

When selecting the Simplex - Network Camera speaker only mode, the speaker connected 
to the camera plays audio, but no audio is transmitted from the camera to other web 
clients. This could be used to provide spoken instructions to a person seen in the camera. 
This mode requires you to use the push-to-talk button.

Simplex - Network Camera microphone only mode transmits audio only from the AXIS 
210A/211A to web clients. It does not receive audio from any other web clients. This can 
be used in remote monitoring, and web attractions to provide live audio and video of a 
monitored situation.

Audio Input

Audio from an external microphone or a line source can be connected to the Line/Mic in 
jack of the AXIS 210A/211A. The audio source can be set to Internal microphone, External 
microphone or Line. If you are using a microphone, the input sensitivity can be set to 
High or Low. See Technical Specifications, on page 57 for the exact maximum levels.

The Enable microphone power option provides DC power for an external microphone. If 
using a small electret condenser microphone such as a clip-on microphone or a PC 
microphone, this option needs to be enabled. 

To use a high impedance dynamic microphone, DC power should not be enabled. DC power 
will not harm the microphone, but if you are uncertain, try switching it off and on. The 
default value is DC power enabled. To use a professional microphone requiring 48V 
phantom power, you need an external power supply and must use a balanced-unbalanced 
converter (audio transformer) in between. 
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If there are problems with the sound input being too low or high, adjust the input gain for 
the microphone attached to the AXIS 210A/211A.

Audio Output

If the sound from the speaker is too low or high, adjust the output gain for the active 
speaker attached to the AXIS 210A/211A. 

When satisfied with the settings, click Save, or click Reset to revert to the previously saved 
settings.

Advanced Audio Settings
The Audio Quality Settings allow you to fine-tune the internal or external microphone 
connected to the AXIS 210A/211A to suit your environment.

Enable speech filter improves the sound quality when the microphone is placed close to 
the person talking and can also help reduce background noise. The filter cuts the lowest 
and the highest frequencies. The bypass frequency range is approximately 250Hz to 
3700Hz (measured at -10dB cut-off break points).

Enable echo cancellation - if audio from the speaker is captured by the microphone, this 
produces an echo. Enable this option to reduce acoustic echoing. 

Noise canceling is a way of reducing the background noise when there is no useful audio 
present. A typical application could be that the camera is set up in a noisy environment, 
and you are only interested in hearing the sound from the AXIS 210A/211A when 
someone is speaking close to the microphone.

There are two adjustable parameters available for noise cancellation:

• Noise canceller threshold value 
• Noise canceller attenuation 
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When the incoming sound is louder than the threshold it passes without being affected. 
When lower than the threshold, the incoming sound is reduced by a certain attenuation 
factor. The threshold level should be set higher than the background noise, but lower than 
the useful audio. 

The noise canceller threshold value can be set to High, Medium High, Medium low or 
Low. A lower threshold allows most audio to pass; only the weakest background noise is 
reduced. A higher threshold makes the noise canceller act on even stronger background 
noise. At the maximum level - High - there is a risk of reducing useful audio as well. 

There is thus always a trade-off between noise canceling and sound quality. In other 
words, increasing the noise canceller attenuation results in deterioration in sound quality. 
To adjust the threshold and attenuation to an optimum level, change the levels and then 
listen to the result.

AXIS Media Control (AMC)

The AMC control panel can also be used to configure various audio settings, such as start 
settings and talk button options. The AMC control panel can be opened by right-clicking 
on the video image in the Live View web page. Please see the readme file included in the 
tool for more information. 
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Live View Config
These are tools for deciding the layout 
of the camera’s Live View page. The 
layout can be set in two ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify 
the default Live View page 
with your own colors, images 
and so on. Click the Config-
ure button and see below.

The other settings on this page concern 
other features to include, such as 
buttons and links. See page 32 for more 
information.

The Custom settings 
window

Click the Configure button in 
the Live View Layout page to 
access the Custom Settings 
window. Here you can 
customize the appearance of 
the default Live View page to 
suit your requirements, or 
you can upload and use your 
own home page. To upload 
your own files, click the 
Upload/Remove button and 
see the description below.

Upload Own Web Files

Your own background pictures, banners and logos can either be located externally on a 
network server, or they can be uploaded to the AXIS 210A/211A itself. Once uploaded, 
files are displayed in the Own drop-down lists. Follow these instructions to upload a file.

1. Click the Upload/Remove button in the Custom settings dialog.
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2. Enter the path to the file on your computer or click the Browse button.

3. Select the user level for the uploaded file. This enables you to determine the pages 
that the users can view.

4. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of this dialog. To remove a file, 
check the box provided next to it and then click the Remove button.

Note: To use your own logo in the camera’s web pages, the file must be in gif format and the file name must be in 
lower case e.g. mylogo.gif 

Modify the Axis Look

Adjust the settings under Modify the Axis look, to change the background picture, banner, 
colors and so on. 

To use your own file for a banner, first upload it (see the following page) or select External 
and enter the path to the file. 
 
If you uncheck the box against Show setup link this removes the setup link from the 
camera’s Home Page. You can then access the menus for setting up the camera by entering 
the full setup address into the address/URL field of a browser: 

Own Home Page

From Live View Layout, select the radio button Use custom settings and click Configure. 

Check the box Use own home page in the Custom Settings dialog, To use a previously 
uploaded web page (see above) as the default home page, select the page from the 
drop-down list and click OK. 

Default Video Format 

Select the default format to use on the Live View page. Checking the box against Show 
video format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

Note: It is also possible to view Motion JPEG when MPEG-4 is chosen as default and vice versa.

Default Viewer

When using Microsoft Internet Explorer (IE) for Windows, select your preferred method of 
viewing moving images. The options are: 

http://<IP address>/operator/basic.shtml
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• AMC(ActiveX)- This is the best choice for fast image updating in Internet 
Explorer, but might not be possible on computers that have restriction on the 
installation of additional software.

• QuickTime - For use with MPEG-4 only, select this to use the QuickTime plug-in 
for Microsoft Internet Explorer.

• Java applet - This alternative uses a Java applet to update the images in the 
browser.

• Still Image - Displays still images only. Hit the Refresh button in your browser to 
view a new image.

When using any other browser than Internet Explorer for Windows, select the appropriate 
method from the drop-down list for viewing images. The available options are similar to 
Internet Explorer except for Server Push. With this method, the camera maintains and 
controls an open HTTP connection to the browser and sends data as and when required for 
as long as required. Please see the online help for more information.

Viewer settings

Checking the Show viewer toolbar option displays the viewer toolbar under the video 
stream in your browser. 

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer. See also AXIS Media Control, on page 24.

Check the record button to record the current video stream. The location where the image 
file is saved can be specified using the AMC Control Panel.

Action Buttons

The manual trigger buttons can be used to manually trigger and stop an event from the 
Live View page. See Event Configuration, on page 36.

Enabling the display of the Snapshot button allows users to save a snapshot from the 
video stream by clicking the button. This button is mainly intended for use with browsers 
other than Internet Explorer for Windows, or when otherwise not using AXIS Media 
Control (AMC) to view the video stream. AMC for Internet Explorer provides its own 
snapshot button.
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User Defined Links

Enter a descriptive name and enter 
the URL in the provided field. 

Example

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. My 
Website

3. Check the radio button for web 
link.

4. Enter the web link: e.g. 
http://www.example.com

5. Click Save.

This link appears on the Live View 
page and opens the specified website.

User-defined CGI links can be used to issue advanced commands via the Axis HTTP API. 
For more information, see the Developer pages at www.axis.com/developer

HTML Examples
You can add live video from the cameras to your own web site. The camera can transmit a 
Motion JPEG or unicast MPEG-4 stream to up to 20 simultaneous connections, although 
an administrator can restrict this to fewer. If multicast MPEG-4 is used, the video stream 
will be available to an unlimited number of viewers connected to the parts of the network 
where multicast is enabled. Please note that a separate MPEG-4 license is required for each 
viewer.

Enter the Video Format, Image type, Image size and other settings to suit your Web page 
and click Update. The camera then generates the required source code for your 
configuration. Copy this code and paste it into your own Web page code. 

External Video
The cameras can also display video images from other Axis network cameras and video 
servers, directly on the Live View page. These are known as External Video sources. These 
external video sources are available from the drop-down list on the Live View page. 

Click the Add button to open the External Video Source Setup dialog, which is used to 
make all the necessary settings. Enter the IP address or host name of the external video 
source you wish to add. Depending on the external source, then select either MPEG-2, 
MPEG-4 or Motion JPEG as the type of video stream you want to receive.

User Defined link
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Example of a path to an external video source:

Sequence Mode
The Live View page can be configured to rotate through the internal and selected external 
video sources, in order, or at random.

Select the desired video sources and enter the time in seconds to display each source (up to 
59 minutes). Click Save.

The Sequence buttons appear on the Live View page to enable the viewer to start and stop 
the sequence mode.

Please see the online help for more information.

http://192.168.0.125/axis-cgi/mjpeg/video.cgi
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Event Configuration
An event in the camera happens when an Event Type is activated and results in certain 
actions. The event type is the set of parameters (or conditions) that define these actions. An 
example of an event type is the camera uploading images when an alarm occurs. Many 
event types use an Event Server, to upload images to - for example.

This section describes how to set up event servers and event types, that is how to configure 
cameras to perform certain actions in response to events occur.

Definitions

Event Servers
Event Servers can be used to receive uploaded image files and/or notification messages. To 
set up Event server connections in your cameras, go to Setup > Event Configuration > 
Event Servers and enter the required information for the required server type.

For details on each setting, please see the online help  available from each web page.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test takes approximately 10 seconds). 

Event type A set of parameters describing how and when the camera performs certain actions

Triggered Event - see page 37
An event that is started by some sort of signal, for example, an external device such as a door 
switch, motion detection, or system event.

Scheduled Event - see page 38 Pre-programmed time period(s) during which an event runs.

Action
This occurs when the event runs, for example, uploading of images to an FTP server, or email 
notification.

Server type Purpose Information required

FTP Server • Receives uploaded images • Descriptive name of your choice
• Network address (IP address or host name)
• User Name and Password 
• Upload path e.g. images/
• Port number
• Use passive mode if there is a firewall between the camera 

and FTP server
• Use temporary file if your FTP server doesn’t allow an existing 

file to be overwritten by a new file with the same name

HTTP Server • Receives notification messages
• Receives uploaded images

• Descriptive name of your choice
• URL (IP address or host name)
• User Name and Password 
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

TCP Server • Receives notification messages • Descriptive name of your choice
• Network address (IP address or host name)
• User Name and Password 
• Port number
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Configuring Event 
Types
An Event Type describes 
how and when the camera 
performs certain actions.

Example: If somebody passes in 
front of the camera and an event that 
uses motion detection has been con-
figured to act on this, the camera can 
record and save images to an FTP 
server, and/or send a notification e-mail to a pre-configured e-mail address with a pre-configured message. Images 
can be sent as e-mail attachments.

Triggered Event

A triggered event can be activated by:

• a push button connected to the camera’s input port
• a manual action such as clicking the trigger button in the web interface
• detected movement in a configured motion detection window
• on restart (reboot) after power loss

How to set up a triggered event

This example describes how to set up the camera to upload images when the main door is 
opened:

1. Click Add triggered on the Event Types page.

2. Enter a descriptive name for the event, such as Main door open.

3. Set the priority - High, Normal or Low (see the online help).

4. Set min time interval between triggers - this is the minimum time period that 
the event type must wait after a trigger and before the next trigger. The interval 
commences as soon as the first trigger occurs. The shortest possible interval is 1 
second and the longest is 23 hours, 59 minutes and 59 seconds. If you do not 
want to not use a minimum interval, set this option to 00:00:00 

5. Set the Respond to Trigger... parameters to define when the event is active, such 
as only after office hours.

6. Select the trigger alternative from the Triggered by... drop-down list. For example 
select Input ports, for a sensor connected to the door.

7. Set the When Triggered... parameters, that is, define what the camera does if the 
main door is opened, such as upload images to an FTP server or send an e-mail 
notification.

8. Click OK to save the event in the Event Types list.



 38 AXIS 210A/211A - Event Configuration
Please see the online help for descriptions of each available option.

Note: Up to 10 event types can be configured in the cameras, and up to 3 of these can be configured to upload 
images. Files names can be formatted according to specific requirements. See File Naming & Date/Time 
Formats online help.

Pre-trigger and Post-trigger buffers

This function is very useful when checking to see what happened immediately before 
and/or after a trigger, e.g. 5 seconds before and/or after a door was opened. Check the 
Upload images checkbox under Event Types > Add Triggered... > Triggered by... . All 
uploaded images are JPEG images.

Include pre-trigger buffer - images stored internally in the server from the time 
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the 
desired length of time and specify the required image frequency. 

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger. 

Notes: Pre-trigger and Post-trigger buffers are lost if the connection to the event server fails.

The maximum length of the pre-/post-buffer depends on the video image size and selected frame rate.

If the pre- or post-buffer is too large for the camera’s internal memory, the frame rate is reduced and indi-
vidual images may be missing. If this occurs, an entry is created in the unit's log file.

Continue image upload (unbuffered) - enables the upload of video images for a fixed 
length of time. Specify the length of time for the uploaded recording, in seconds, minutes 
or hours, or for as long as the trigger is active. Finally, set the desired image frequency to 
the maximum (the maximum available) or to a specified frame rate. The frame rate is the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled Event

A Scheduled event can be activated at preset times, in a repeating pattern on selected 
weekdays.

Configuration example: 

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, such as “Scheduled e-mail upload.”

3. Set the priority (High, Normal or Low).

4. Set the Activation Time parameters (24h clock) defining when the event is active, 
e.g. start on Sundays at 13.00 for a duration of 12 hours.

5. Set the When Activated... parameters, defining what the camera does at the 
specified time, such as send uploaded images to an e-mail address.
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6. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.

Camera Tampering
The camera tampering application generates an alarm whenever the camera is 
repositioned, or when the lens is covered, sprayed or severely put out of focus.

The Minimum duration parameter defines the time that must elapse before the alarm goes 
off after the tampering. This helps prevent false alarms.

Check the Alarm for dark images box if there should be an alarm when the camera lens is 
sprayed and the image is dark.

Motion Detection
Motion detection is used to generate an alarm whenever movement occurs (or stops) in the 
video image. A total of 10 Include and/or Exclude windows can be configured.

• Included windows target specific areas within the whole video image
• Excluded windows define areas within an Include window that should be ignored 

(areas outside Include windows are automatically ignored)
Once configured, the motion detection windows appear in the list of available triggers, for 
triggering events. See “How to set up a triggered event” on page 37.

Note: Using the motion detection feature may decrease the camera’s overall performance.

Configuring Motion Detection

1. Click Motion Detection in the Event Configuration menu.
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2. Click the Add Window button.

3. Select the Include or Exclude option to define an Include or Exclude window, and 
enter a descriptive name in the field below.

4. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

5. Adjust the Object Size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

6. Click Save.

Note: To exclude parts of the Include window, click the Configure Excluded Windows button and position the 
Exclude window as required, within the Include window.

Please see the online help for descriptions of each available option.

Examples: 

• Avoid triggering on small objects in the video image by setting the object size level to high.
• To reduce the number of triggers if there is a lot of movement during a short period of time, select a high 

history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status
Under Event Configuration > Port Status there is a list showing the status for the 
cameras’s input and output. This is for the benefit of Operators, who have no access to the 
System Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit - as long as the but-
ton is not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.

 Object Size History Sensitivity

High level Only very large objects 
trigger motion detection

An object that appears in the region trig-
gers the motion detection for a long 
period

Ordinary colored objects on ordinary 
backgrounds trigger the motion detection

Low level Even very small objects 
trigger motion detection

An object that appears in the region trig-
gers motion detection for only a very 
short period

Only very bright objects on a dark back-
ground trigger motion detection

Default value Low Medium to High Medium to High
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System Options

Security
User access control is enabled by default, when the administrator sets the root password on 
first access. An administrator can set up other users, by assigning user names and 
passwords. It is also possible to allow anonymous viewer login, which means that anybody 
may access the Live View page.

The AXIS 210A/211A Network Camera supports several methods of user authentication:

HTTP Basic Authentication - This authenticates the user by requesting a user name and a 
password. The exchange of network credentials is in simple base64 coding and is not 
encrypted.

HTTP Digest Authentication - This method also requests a user name and password, but 
the exchange of credentials is encrypted, which secures it against eavesdropping. 

Users 

User List - the user list displays the authorized users and user groups (levels):

User Settings - check the relevant checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View 
page.

• Maximum number of simultaneous viewers limited to - enter a value here to 
restrict the number of unicast viewers accessing the unit. This is useful if you 
need to save on bandwidth. (Note that all multicast viewers count as one viewer.)

IP Address Filtering

Enable IP Address Filtering: To allow or deny access to the AXIS 210A/211A Network 
Camera check the box Enable IP address filtering. Once enabled, the IP addresses in the 
list are allowed or denied access according to the choice made in the drop-down list 
Allow/Deny the following IP addresses. 

The administrator can add up to 256 IP address entries to the list (a single entry can 
contain multiple IP addresses). The users from these IP addresses need to be specified in the 
user list with the appropriate access rights. This is done from Setup > System Options > 
Security > Users. 

Viewer Provides the lowest level of access, which only allows access to the Live View page.
Operator An operator can view the Live View page, create and modify event types and adjust certain other 

settings. Operators have no access to the System Options.
Administrator An administrator has unrestricted access to all the setup options and can determine the registration 

of all other users. 
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Referrals - To prevent unauthorized clients from including the video stream from the 
cameras into external Web pages, check the Referrals checkbox and enter the IP address or 
host name of the computer that hosts the Web pages with the included video stream. 
Several IP addresses/host names can be defined and are separated by semicolons (;). This 
option is only applicable to Motion JPEG video streams.

Notes: If the referrals feature is enabled and you wish to also allow normal access to the Live View page, the 
product's own IP address or host name must be added to the list of allowed referrers.

Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP address fil-
tering must be enabled.

Restricting referrers is of greatest value when not using IP address filtering. If IP address filtering is used, 
then the allowed referrers are automatically restricted to those allowed IP addresses.

HTTPS

The AXIS 210A and the AXIS 211A both support encrypted browsing using HTTPS. 

A self-signed certificate can be used until a Certificate Authority-issued certificate has 
been obtained. Click the Create self-signed Certificate button to install a self-signed 
certificate. Although self-signed certificates are free and offer some protection, true 
security is implemented after the installation of a signed certificate issued by a certificate 
authority. 

A signed certificate can be obtained from an issuing Certificate Authority by clicking the 
Create Certificate Request button. When the signed certificate is returned, click the Install 
signed certificate button to import the certificate. The properties of any certificate request 
currently resident in the camera or installed can also be viewed by clicking the 
Properties... button. The HTTPS Connection Policy must also be set in the drop-down lists 
to enable HTTPS in the camera.

For more information, please refer to the online help.  

IEEE 802.1x

IEEE 802.1x is an IEEE standard for port-based Network Admission Control. It provides 
authentication to devices attached to a network port (wired or wireless), establishing a 
point-to-point connection, or, if authentication fails, preventing access on that port. 
802.1x is based on EAP (Extensible Authentication Protocol). 

In a 802.1x enabled network switch, clients equipped with the correct software can be 
authenticated and allowed or denied network access at the Ethernet level. 



 43 AXIS 210A/211A - System Options
Clients and servers in an 802.1x network may need to authenticate each other by some 
means. In the Axis implementation this is done with the help of digital certificates 
provided by a Certification Authority. These are then validated by a third-party entity, 
such as a RADIUS server, examples of which are Free Radius and Microsoft Internet 
Authentication Service.

To perform the authentication, the RADIUS server uses various EAP methods/protocols, of 
which there are many. The one used in the Axis implementation is EAP-TLS 
(EAP-Transport Layer Security). 

The AXIS network video device presents its certificate to the network switch, which in turn 
forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate 
and responds to the switch, and sends its own certificate to the client for validation. The

switch then allows or denies network access accordingly, on a preconfigured port. 
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The authentication process

RADIUS

RADIUS (Remote Authentication Dial In User Service) is an AAA (Authentication, 
Authorization and Accounting) protocol for applications such as network access or IP 
mobility. It is intended to work in both local and roaming situations.

CA servers

In cryptography, a Certification Authority (CA) is an entity that provides signed digital 
certificates for use by other parties, and thus acts a trusted third party. 

There are many commercial CAs that charge for their services. Institutions and 
governments may have their own CA, and there are free CAs available. 

Protected network

Axis video device

Q: Certificate OK?

Certificate 
Authority (CA)

3

1

2

4

A: OK

RADIUS
server

Network
switch

Q: Certificate OK?
A: OK

Certificate

Certificate

1. A CA server provides the required signed certificates.

2. The Axis video device requests access to the protected network at the network switch. 
The switch forwards the video device’s CA certificate to the RADIUS server, which then 
replies to the switch.

3. The switch forwards the RADIUS server’s CA certificate to the video device, which 
also replies to the switch. 

4. The switch keeps track of all responses to the validation requests. If all certificates are 
validated, the Axis video device is allowed access to the protected network via a 
preconfigured port.
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Date & Time
Current Server Time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in the Overlay Images (see below).

New Server Time - select your time zone from the drop-down list. If you want the server 
clock to automatically adjust for daylight savings time, select the Automatically adjust for 
daylight saving time changes. 

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your 
computer. 

• Synchronize with NTP Server - the camera obtains the time from an NTP server 
every 60 minutes. The NTP server's IP address or host name must be specified in 
the TCP/IP Advanced Settings - see page 46.

• Set manually - this option allows you to manually set the time and date.
Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 

See Network > Basic TCP/IP Settings below.

Date & Time Format Used in Images - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced 
File Naming & Date/Time Formats in the help files for information on how to create 
your own file formats.
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Network 

Basic TCP/IP Settings

IP Address Configuration

Your Axis network camera supports both IP version 4 and IP version 6. Both versions may 
be enabled simultaneously, and at least one version must always be enabled. 

When using IPv4, the IP address can be set automatically via DHCP, or a static IP address 
can be set manually. 

If IPv6 is enabled, your camera will receive an IP address according to the configuration in 
the network router.

There are also options for setting up notification of changes in the IP address, and for 
using the AXIS Internet Dynamic DNS Service. For more information on setting the IP 
address, please see the online help.

Notes: • DHCP is a protocol for automatic IP address assignment on a network. IP address 
assignment via DHCP may lead to the situation where the IP address changes and you lose 
contact with the camera. Configure the options for notification of IP address change (under 
Services) to receive notification from the camera when the IP address changes.
• Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 
210A/211A by host name which is always the same, regardless of the IP address.

Services

Options for notification of IP address change - if the IP address for the video server 
changes, e.g. automatically by DHCP, you can choose to be notified of the change. Click 
Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - The AXIS Internet Dynamic DNS Service can 
provide your Axis product with its own URL (web address), which can then be used to 
access it over the Internet. The product can be unregistered from the service at any time. 
To do this click Settings... and follow the instructions. For more information, please refer 
to the online help.

Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on 
your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.
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Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
210A/211A. Multiple domains can be separated by semicolons (;). The host name is always 
the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully 
Qualified Domain Name myserver.mycompany.com where mycompany.com is the 
Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

Note: This is not mandatory with regard to secondary DNS servers.

NTP Configuration

The AXIS 210A/211A can obtain the correct time from an NTP server. The address for the 
NTP server can either be obtained via the DHCP server, or it can be entered manually. 

Host Name Configuration

The AXIS 210A/211A can be accessed using a host name, instead of an IP address. The 
host name is usually the same as the assigned DNS Name.

For more information, please see the online help

Link-Local IPv4 Address

This is enabled by default and assigns the AXIS 210A/211A an additional IP address for 
use with UPnP™. The AXIS 210A/211A can have both a Link-Local IP and a 
static/DHCP-supplied IP address at the same time - these will not affect each other. 

HTTP 

The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for simple security port mapping.

HTTPS

The default HTTPS port number (443) can be changed to any port within the range 
1024-65535. HTTPS is used to provide encrypted web browsing.

NAT Traversal (port mapping) for IPv4

A broadband router allows devices on a private network (LAN) to share a single connection 
to the Internet. This is done by forwarding network traffic from the private network to the 
“outside” i.e. the Internet. Security on the private network (LAN) is increased since most 
broadband routers are pre-configured to stop any attempt to access the private network 
(LAN) from the public network/Internet.
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Use NAT traversal when your AXIS 210A/211A is located on an intranet (LAN) and you 
wish to make it available from the other (WAN) side of a NAT router. With NAT traversal 
properly configured, all HTTP traffic to an external HTTP port in the NAT router is 
forwarded to the camera.

Notes: • For NAT traversal to work, this must also be supported by the broadband router.
• The broadband router has many different names: “NAT router”, “Network router“, 
Internet Gateway”, “Broadband sharing device” or “Home firewall” but the essential purpose 
of the device is the same.

Enable/Disable - When enabled, the AXIS 210A/211A attempts to configure port mapping 
in a NAT router on your network, using UPnP™. Note that UPnP™ must be enabled in the 
camera (see System Options > Network > UPnP).

Use manually selected NAT router - Select this option to manually select a NAT router 
and enter the IP address for the router in the field provided.

If a router is not manually specified, the AXIS 210A/211A automatically searches for NAT 
routers on your network. If more than one router is found, the default router is selected.

Alternative HTTP port - Select this option to manually define an external HTTP port. Enter 
the port number in the field provided. If no port is entered here a port number is 
automatically selected when NAT traversal is enabled. 

Notes: • An alternative HTTP port can be used/be active even if NAT traversal is disabled. This is 
useful if e.g. your NAT router does not support UPnP and you need to manually configure 
port forwarding in the NAT router.
• If you attempt to manually enter a port that is already in use, another available port us 
automatically selected.
• When the port is selected automatically it is displayed in this field. This can be changed 
by entering a new port number and clicking Save.

FTP

The FTP server running in the AXIS 210A/211A enables the upload of e.g. new firmware, 
user applications, etc. Check the box to enable the service.

RTSP

LAN (intranet) WAN (internet)

Broadband 
(NAT)
router

ISP
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The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is 554.

Network Traffic 

The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth the AXIS 
210A/211A is allowed to use on your network. This is a useful function when connecting 
the camera to busy or heavily loaded networks. The default setting is Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help .

SOCKS 

SOCKS is a network proxy protocol. The cameras can be configured to use a SOCKS server 
to reach networks on the other side of a firewall/proxy server. This functionality is useful if 
the camera is located on a local network behind a firewall, but notifications, uploads, and 
alarms need to be sent to a destination outside the local network (such as to the Internet).

QoS 

Quality of Service (QoS) provides the means to guarantee a certain level of a specified 
resource to selected traffic on a network. Quality can be defined as a maintained level of 
bandwidth, low latency, no packet losses, and so on. The main benefits of a QoS-aware 
network can be summarized as:

• The ability to prioritize traffic and thus allow critical flows to be served before 
flows with lesser priority.

• Greater reliability in the network, thanks to the control of the amount of band-
width an application may use, and thus control over bandwidth races between 
applications.
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The QoS in Axis network video products marks the data packets for various types of 
network traffic originating from the product. This makes it possible for network routers 
and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The 
following types of traffic are marked:

• live video
• live audio
• event/alarm traffic
• management network traffic.

QoS Settings 

For each type of network traffic supported by your Axis network video product, enter a 
DSCP (Differentiated Services Codepoint) value. This value is used to mark the traffic’s IP 
header. When the marked traffic reaches a network router or switch, the DSCP value in the 
IP header tells the router or switch which type of treatment to apply to this type of traffic, 
for example, how much bandwidth to reserve for it. 

Note that DSCP values can be entered in decimal or hex form, but saved values are always 
shown in decimal.

For more information on Quality of Service, please see the Axis support web at 
www.axis.com/techsup

SMTP (email)

Enter the host names or addresses for your primary and secondary mail servers in the 
fields provided, to enable the sending of event and error e-mail messages from the camera 
to predefined addresses via SMTP.

SNMP

The Simple Network Management Protocol (SNMP) allows remote management of network 
devices. Depending on the level of security required, select the version of SNMP to use. The 
three levels of security are:

• SNMP V1 - includes no security.
• SNMP V2c - uses very simple security. The community name can be specified as a 

password for read or read/write access to all supported SNMP objects. The com-
munity is the the group of network devices using SNMP.

• SNMP V3 - provides encryption and secure passwords. HTTPS must be enabled.
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UPnP™

The cameras includes support for UPnP™. UPnP™ is enabled by default, and the network 
camera then is automatically detected by operating systems and clients that support this 
protocol. If also enabled on your computer, the camera is automatically detected and a new 
icon is added to “My Network Places.” 

Note: UPnP must also be enabled on your Windows XP or ME computer. To do this, open the Control Panel from 
the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and open 
the Networking Services section. Click Details and then select UPnP as the service to add.

RTP

These settings are for the IP addresses, port numbers, and Time-To-Live values to use for 
media streams in the MPEG-4 format. Only certain IP addresses and port numbers should 
be used for these streams. For more information, please see the online help.

Bonjour

Your Axis network camera includes support for Bonjour. When enabled, the camera is 
automatically detected by operating systems and clients that support this protocol. 

Ports & Devices
I/O Ports - the pinout, interface support and the control and monitoring functions 
provided by this connector are described in The I/O Terminal Connector, on page 55.

LED
The Status indicator LED on the front of the camera can be set to flash at a configurable 
interval (or to not light up at all) whenever the unit is accessed. For a listing of all LED 
behavior, see page 8, or the online help.

Note: The LED does not flash when the stream is retrieved using MPEG-4 multicast.

Maintenance
• Restart - the camera is restarted without changing any of the settings. Use this 

method if the unit is not behaving as expected.
• Restore - the unit is restarted and most current settings are reset to factory default 

values. The settings that are reset are as follows:
• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
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• the system time
• Default - the default button should be used with caution. Pressing this returns all 

of the camera's settings (including the IP address) to the factory default values. 
Upgrade Server - See Upgrading the Firmware, on page 64.

Backup - click this button to take a backup of all the parameters, and any user-defined 
script. You can then return to the previous settings, if settings are changed and there is 
unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings are restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for the configuration of multiple units or for firmware upgrades.

Support
The Support Overview page provides valuable information on troubleshooting and 
contact information, should you require technical assistance.

System Overview - is a quick look over the camera’s status and settings. Information be 
found here includes the camera’s Firmware version, IP address, Security, Event and 
Image Settings and Recent Log Items. Many of the captions are also links to the proper 
Setup page to conveniently make adjustments in the cameras settings. 

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

Information

The Log file, the Server Report and the Parameter List all provide valuable information 
for troubleshooting and when contacting Axis support.

Configuration

Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for E-mail - select the level of information from the drop-down list to send as 
e-mail and enter the destination e-mail address.

Advanced
Scripting - this an advanced function that provides the means for customizing and using 
scripts.
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Caution!
The scripting function is a very powerful tool. Improper use may cause unexpected 
behavior or even loss of contact with the unit. If a script does cause problems, reset the 
unit to its factory default settings (in which case, a previously saved backup file is useful 
for returning the unit to its latest configuration). Axis recommends that you do not use 
this function unless you fully understand the consequences. Axis support provides no 
assistance for customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with previous experience of 
configuring Axis cameras. All parameters can be set and modified from this page. Help is 
available via the links on the standard setup pages.

Resetting to Factory Default Settings
To reset the cameras to the original factory default settings, go to the System Options > 
Maintenance web page (as described in Maintenance, on page 51) or use the Control 
button on the side of the camera (see page 7) as described below:

Using the Control Button

To reset the cameras to the factory default settings using the Control Button:

1. Disconnect the power adapter, or the network cable if using PoE  
(AXIS 210A/AXIS 211A only).

2. Press and hold the Control button while reconnecting the power.

3. Keep the Control button pressed until the Status Indicator color changes to amber 
(this may take up to 15 seconds).

4. Release the Control button.

5. When the Status Indicator changes to green (which may take up to 1 minute), the 
process is complete and the cameras has been reset. The unit now has the default 
IP address 192.168.0.90.

Note: For other methods of setting the IP address, please refer to the product’s Installation Guide that accompa-
nies the product, or download a copy from www.axis.com

Language
The language used in the AXIS 210A/AXIS 211A can be changed so that all web pages 
appear in the selected language.

You need to upload the language file first, before you can select it. Click the Browse button 
and locate the language file. Click Upload Language to upload the file. The new language 
now appears in the list under Select Language. Select the language and click Save to save 
the selection.
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About
Here you can find basic information about your network camera. You can also view third 
party software licenses.
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The I/O Terminal Connector

Pinout and Interface

The 4-pin I/O terminal connector provides the interface to: 

• 1 transistor output
• 1 digital input
• auxiliary power and GND

The terminal connector is used in applications for motion detection, event triggering, time 
lapse recording, alarm notification via e-mail, image storage to FTP locations, and so on.

• Input - for connecting a push button for example. If the push button is pressed, 
the state changes and the input becomes active (shown under Event Configura-
tion > Port Status).

• Output - connects an alarm device that can be activated by Output buttons on the 
Live View page, or by an Event Type. The output shows as active (Event Config-
uration > Port Status) if the alarm device is activated. 

Connect input/output devices to the terminal connector as follows:

1. Loosen the corresponding screw on top of the pin (see above for the correct pin).

2. Push the cable into the connector and secure it by fastening the screw.

Pin Function Description
4 Transistor Output With a maximum load of 100mA and a maximum voltage of 24V DC, this output 

has an open-collector NPN transistor with the emitter connected to pin 1 (GND). 
If used with an external relay, a diode must be connected in parallel with the load, 
for protection against voltage transients.

3 Digital Input Connect to GND to activate, or leave floating (or unconnected) to deactivate.

2 Auxiliary DC Power Input 7-20 VDC/max 5W. Electrically connected in parallel with the PS-K power 
connector, this pin provides an auxiliary connector for mains power to the unit. If 
the unit is powered via this pin, a fuse should be used (rating: 1A Slow). 
This pin can also be used to power auxiliary equipment, max 100mA, but note that 
this is not possible when the AXIS 210A/AXIS 211/211A is powered by PoE.

1 GND Ground

Pin 4
Pin 3

Pin 2
Pin 1

Pin 4
Pin 3

Pin 2
Pin 1
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3. Once devices are connected, connect the terminal connector to the camera, 
making sure that all cables are securely fastened.

Schematic Diagram - Terminal Connectors

Switch
Mode
Power
Supply

3.3V

PS-K 9W

e.g., doorbell
Relay

Device

GND

- +

+

2

1

3
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Technical Specifications

Item Specification

Models • AXIS 210A: indoor use only
• AXIS 211A: varifocal DC-Iris; indoor/outdoor

Image sensor • 1/4” Sony Wfine progressive scan RGB CCD 

Lens • AXIS 210A: 4.0 mm, F1.2, fixed iris, CS mount 
• AXIS 211A: 3.0 - 8.0 mm, F1.0, DC-iris, CS mount 

Angle of view • AXIS 210A: 48° horizontal
• AXIS 211A: 27º-67º horizontal

Minimum illumination • AXIS 210A: 1.0 lux, F1.2
• AXIS 211A: 0,75 lux, F1.0

Video compression • Motion JPEG
• MPEG-4 Part 2 (ISO/IEC 14496-2), Profiles: ASP and SP 

Resolutions 16 resolutions from 640 x 480 to 160 x 120 via API, 5 selections via configuration 
web page 

Frame rate • Motion JPEG: 
Up to 30 fps in all resolutions

• MPEG-4:  
Up to 25 fps at 640x480 
Up to 30 fps at 480x360 or lower

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and bandwidth
• Constant and variable bit rate (MPEG-4) 

Image settings • Compression levels: 11 (Motion JPEG)/23 (MPEG-4)
• Rotation: 90º, 180º, 270º
• Mirroring
• Configurable color level, brightness, contrast, exposure, white balance, fine 

tuning of behavior at low light
• Overlay capabilities: time, date, privacy mask, text or image 

Shutter time • 1/12500 to 2 sec
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Audio • Two-way (full or half duplex), one-way or audio off.
• Encoding formats (selected under System Options):

ADPCM format at 24kbps, 8 kHz sampling (G.726 - select G723 from 
drop-down list)
ADPCM format at 32kbps, 8 kHz sampling (G.726 - select G721 from 
drop-down list)
PCM μ−law format at 64kbps, 8 kHz sampling (G.711 default)

• Built-in microphone, external microphone input or line input. Mono audio 
output (line level) connects to PA system or active speaker with built-in 
amplifier.

• External audio input: Single 3.5mm input for a mono microphone, or line-in 
mono signal (left channel is used from a stereo signal). 

• Microphone input sensitivity: High = max -38 dBu (27 mVpp), Low = max -18 
dBu (275 mVpp) 

• Line input - max: 11.2 dBu (8.0 Vpp); Line output - max: 3Vpp
• DC power through input connector for external microphones supported.
• Audio output (line level) connects to PA system or active speaker with built-in 

amplifier. Headphones can also be connected. A stereo connector must be used 
for the audio out. 

• Audio output: max 3.0 Vpp (+2.7dBu) 
• Audio output impedance: min 38 ohm; max 10 ohm
• Audio input impedance: 7kohm
• Audio compression: G.711 PCM 64kbit/s, G.726 ADPCM 32 or 24 kbit/s

Security • Multiple user access levels with password protection
• IP address filtering
•  HTTPS encryption
• Network access control IEEE801.1X
• User access log

Users • 20 simultaneous users 
• Unlimited users using multicast (MPEG-4) 

Language support  
(Web interface)

• English. Downloadable language files for French, German, Italian, Japanese and 
Spanish are available at www.axis.com/techsup.

• Other language files may also be available

Alarm and event management • Events triggered by built-in motion detection, audio detection, active tampering 
alarm, external inputs or according to a schedule.

• Image upload over FTP, email and HTTP Notification over TCP, email, HTTP and 
external outputs.

• Pre- and post alarm buffer: up to 9 MB (up to 5 min of 320x240 video at 4 
frames per sec). 

Connectors • RJ-45 for Ethernet 10BaseT/100BaseTX
• Terminal block for 1 alarm input, 1 output and alternative power connection
• 3.5 mm jack for Mic in (max 270mVpp) or Line mono input (3.2Vpp)
• 3.5 mm jack for Line mono output (3.0Vpp) 
• Output impedance: 32 ohm

Casing Plastic

Item Specification
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Processors and memory • CPU: ETRAX 100LX 32bit
• Video processing and compression: ARTPEC-2
• RAM: 32 MB
• Flash: 8 MB
• Battery backed up real-time clock

Power • 7-20 V DC max 7 W
• PoE IEEE802.3af Class 2

Operating conditions •  5 - 45 ºC (41 – 113 ºF), humidity 20 - 80% RH

Installation, management and 
maintenance

• AXIS Camera Management tool on CD and web-based configuration
• Configuration of backup and restore
• Firmware upgrades over HTTP or FTP, firmware available at www.axis.com 

Video access from
Web browser

• Camera live view,
• Video recording to file (ASF),
• Sequence tour for up to 20 external Axis video sources,
• Customizable HTML pages 

Minimum web browsing 
requirements

• Pentium III CPU 500 MHz or higher, or equivalent AMD
• 128 MB RAM
• AGP graphics card 32 MB RAM, Direct Draw
• Windows XP, 2000, 2003 Server
• DirectX 9.0 or later 
• Internet Explorer 6.x or later
• For other operating systems and browsers see www.axis.com/techsup

System integration support • Open API for application integration including AXIS VAPIX API*, AXIS Media 
Control SDK*, event trigger data in video stream

• Quality of Service (QoS) Layer 3, DiffServ Model
• Embedded Linux operating system

* Available at www.axis.com

Supported protocols • IPv4/v6, HTTP with Digest Authentication, HTTPS, SSL/TLS*, TCP, QoS, 
SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, IGMP, RTCP, SMTP, FTP, ICMP DHCP, 
UPnP, Bonjour, ARP, DNS, DynDNS, SOCKS, IEEE802.1X. More information on 
protocol usage available at www.axis.com

*This product includes software developed by the Open SSL Project for use in the 
Open SSL Tool kit (www.openssl.org)

Included accessories • Power supply 9 V DC
• Stand
• Connector kit
• Installation Guide
• CD with installation tool, software and User’s Manual
• MPEG-4 licenses (1 encoder, 1 decoder)
• MPEG-4 decoder (Windows) 

Video management software 
(not incl.) 

• AXIS Camera Station - Surveillance application for viewing, recording and 
archiving up to 50 cameras

See www.axis.com/partner/adp_partners.htm for more software applications via 
partners 

Item Specification
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General performance considerations

When setting up your system, it is important to consider how various settings and 
situations affect performance. Some factors affect the amount of bandwidth (the bit rate) 
required, others can affect the frame rate, and some affect both. If the load on the CPU 
reaches its maximum, this also affects the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the camera’s CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 
210A/211A provides a tool that can be used to display these values directly in the video 
image.

Accessories (not incl.) • Housings for adverse indoor/outdoor environments
• Power over Ethernet midspans
• AXIS 292 Network Video Decoder
• MPEG-4 Decoder multi-user license pack.

Approvals •  EN 55022 Class B
•  EN 61000-3-2
•  EN 61000-3-3
•  EN 55024
•  FCC Part 15 Subpart B Class B
•  ICES-003 Class B
•  VCCI Class B
•  C-tick AS/NZS 3548
•  EN 60950 
• Power supply: EN 60950, UL, cUL

Dimensions (HxWxD) and 
weight 

• AXIS 210A: 38 x 88 x 157 mm (1.5” x 3.4” x 6.2”)
• AXIS 211A: 38 x 95 x 178 mm (1.5” x 3,7” x 7.0”)
• 270 g (0.6 lb) axcl. power supply

Item Specification
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To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in kbps) 
to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats.

Important!
The figures displayed here are the values as delivered by the camera. If other restrictions are currently in 
force, (e.g. bandwidth limitation) these values might not correspond to those actually received by the client.

For Motion JPEG, these values are accurate as long as no frame rate limit has been specified.

Frame rates - Motion JPEG and MPEG-4

The following table show typical frame rates in frames/second (fps) for Motion JPEG and 
MPEG-4 video streams from the AXIS 210A/211A.

Note that these values are guidelines only - actual values may vary. 

Motion JPEG settings:

• Viewing in AMC
• Compression level = 30%

MPEG-4 settings:

• Viewing in AMC
• Compression level = 30%
• Video Object Type = Advanced Simple
• GOV length = 8
• GOV structure = IP*

Note: Setting the GOV structure to use “I-frames only” will increase the frame rate at the expense of the bit rate.

* The GOV structure can take two different forms; I and IP. The I-structure sends complete images 
(I-images) whereas the IP-structure mostly sends the differences compared with the previous image 
(P-images) and only a few I-images. The IP-structure requires much less bandwidth than the I-structure.

 Frame rates
Motion JPEG MPEG-4

640x480 30 25
480x360 30 30
320x240 30 30
160x120 30 30
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Bandwidth

As there are many factors that affect bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure
• the maximum exposure time.

There are also factors in the monitored scene that affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. With multiple 
viewers, and If supported on the network, consider using MPEG-4 multicasting, as the 
bandwidth consumption is much lower.
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Troubleshooting

Checking the Firmware
One of your first actions when troubleshooting a problem should be to check the firmware 
version. The latest version may contain a correction that fixes your particular problem. The 
current firmware version in your camera can be seen on the page Setup > Basic 
Configuration.

Upgrading the Firmware
Firmware is software that determines the functionality of the camera. When you upgrade 
the firmware with a file from the Axis Web site, your camera receives the latest available 
functionality. Always read the upgrade instructions and release notes available with each 
new release, before updating the firmware.

Note: Preconfigured and customized settings are saved when the firmware is upgraded (providing the features 
are available in the new firmware) although this is not guaranteed by Axis Communications. Always read 
the instructions and release notes available with each new release, before upgrading the firmware.

1. Save the firmware file to your computer. The latest version of the firmware is 
available free of charge from the Axis Web site at www.axis.com/techsup

2. Go to Setup > System Options > Maintenance in the camera’s web pages.

3. In the Upgrade Server section, browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: After starting the upgrade process, always wait at least 5-10 minutes before restarting the camera, even if 
you suspect the upgrade has failed.

Your dealer reserves the right to charge for any repair attributable to faulty upgrading by the user.

Emergency Recovery Procedure
If power or the network connection to the camera is lost during the upgrade, the process 
fails and the unit becomes unresponsive. A flashing red Status LED indicates a failed 
upgrade. To recover the unit, follow the steps below. The serial number is found on the 
label attached to the bottom of the camera.
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1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of camera> <Serial number> temp 
ping -s 408 <IP address of camera> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of camera> <Serial number> 
ping -l 408 -t <IP address of camera>

2. If the unit does not reply within a few seconds, restart it and wait for a reply. 
Press CTRL+C to stop Ping.

3. Open a browser and type in the camera’s IP address. In the page that appears, use 
the Browse button to select the upgrade file to use, e.g. axis210.bin or 
axis211.bin. Then click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit automatically restarts 
and shows a steady green on the Power and Status LEDs and flashing green or 
amber on the Network LED. 

5. Referring to the installation guide, reinstall the camera. 

If the emergency recovery procedure does not get the camera up and running again, please 
contact Axis support at www.axis.com/techsup/ 

Axis Support
If you contact Axis support, please help us to help you solve your problems, by providing 
the server report, the log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

The Log file is available from Setup > System Options > Logs & Reports. The Log file 
records events in the unit since the last system restart and can be a useful diagnostic tool 
when troubleshooting.
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Symptoms, Possible Causes and Remedial Actions 
Problems setting the IP address

When using ARP/Ping. Try the installation again. The IP address must be set within two minutes after power has 
been applied to the camera. Ensure the Ping length is set to 408. See the Installation 
Guide.

The camera is located on a different 
subnet.

If the IP address intended for the camera and the IP address of your computer are located 
on different subnets, you will not be able to set the IP address. Contact your network 
administrator to obtain an appropriate IP address. 

The IP address is being used by another 
device

Disconnect the camera from the network. Run the Ping command. (In a Command/DOS 
window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that 
the IP address may already be in use by another device on your network. You must obtain 
a new IP address and reinstall the unit. 

If you see: Request timed out - this means that the IP address is available for use with 
your camera. In this case, check all cabling and reinstall the unit. 

Possible IP address conflict with 
another device on the same subnet.

The static IP address in the camera is used before the DHCP server sets a a dynamic 
address. This means that if the same default static IP address is also used by another 
device, there may be problems accessing the camera. To avoid this, set the static IP 
address to 0.0.0.0. 

The camera cannot be accessed from a browser
The IP address has been changed by 
DHCP.

1) Move the camera to an isolated network or to one with no DHCP or BOOTP server. Set 
the IP address again, using the AXIS IP Utility (see the Installation Guide) or the ARP/Ping 
commands. 
2) Access the unit and disable DHCP in the TCP/IP settings. Return the unit to the main 
network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network set-
tings. Return the unit to the main network. The unit now has a dynamic IP address, but 
will notify you if the address changes. 

Proxy server. If using a proxy server, try disabling the proxy setting in your browser.

Other networking problems. Test the network cable and connectors by connecting it to another network device, then 
Ping that device from your workstation. See the instructions above.

Cannot log in. When HTTPS is enabled, ensure that the correct protocol (HTTP or HTTPS) is used when 
attempting to log in. You may need to manually type in http or https in the browser's 
address bar. 

Incorrect host name. Check that the host name and DNS server settings are correct. See the basic and 
advanced TCP/IP settings. 

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection. The camera can be configured to use a SOCKS server to reach networks on the other side 

of a firewall/proxy server.

Camera is accessible locally, but not externally
Firewall protection. Check the Internet firewall with your system administrator.

Default routers required. Check if you need to configure the default router settings.

Poor or intermittent network connection.
Network switch. If using a network switch, check that the port on that device uses the same setting for 

the network connection type (speed/duplex) as set in the advanced TCP/IP settings.

The Auto-Negotiate setting is recommended.
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Video/Image problems - general
No images in browser 
(Internet Explorer for Windows only)

To enable the updating of video images in Microsoft Internet Explorer for Windows, set 
your browser to allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) 
component is installed on your workstation. 

Installation of additional ActiveX com-
ponent restricted or prohibited.

Configure your camera to use a Java applet for updating the video images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for 
more information.

Image too dark or too light. Check the video image settings. See the online help on Video and Image Settings.

Missing images in uploads. This can occur when trying to use a larger image buffer than is actually available. Try 
lowering the frame rate or the upload period.

Slow image update. Configuring, e.g. pre-buffers, motion detection, high-resolution images, and high frame 
rates, will reduce the performance of the camera. 

Poor performance. Poor performance may be caused by e.g. heavy network traffic, multiple users accessing 
the unit, low performance clients, use of features such as Motion Detection, Event han-
dling, Image rotation other than 180 degrees.

Image gradually gets darker or lighter. When using the camera in locations lit by fluorescent lighting, check in the advanced 
image settings that the Exposure control is set to Flicker-free. 

Image loses focus often. Disable the DC-Iris lens (AXIS 211A only) in the settings for Video & Image > Advanced. 
Focus the camera following the instructions on page 11, and then enable the DC-Iris 
lens. 

Images only shown in black & white. Check the color level setting.

Blurred images. Refocus the camera. Check in the Video & Image > Advanced - Camera Settings that 
DC-Iris (AXIS 211A only) is set to Enabled. If the images are still blurred adjust the metal 
ring until the image is sharp. 

Rolling dark bands or flickering in 
image. 

Try adjusting the Flicker-free exposure setting under advanced image settings. Note that 
the 'Hold Current'/Manual setting may cause unwanted effects. 

Video/image problems - MPEG-4
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the 

settings for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. 
Using an inappropriate video object type can also affect the frame rate. See the online 
help for more information.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to 
Decode only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet 
(network tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control 
panel applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default 
MPEG-4 decoder. 

No multicast MPEG-4 displayed in the 
client.

Check with your network administrator that the multicast addresses used by the  
AXIS 210A/211A are valid for your network.

Multicast MPEG-4 only accessible by 
local clients. 

Check if your router supports multicasting, or if the router settings between the client 
and the server need to be configured. The TTL (Time To Live) value may need to be 
increased.
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Poor rendering of MPEG-4 images. Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to 
enable Advanced Video Rendering. This is done on the MPEG-4 tab in the AMC control 
panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can  
usually be downloaded from the manufacturer's web site. 

If images are degrading, try decreasing the GOV length, see “Advanced Settings” on page 
22.

Color saturation is different in MPEG-4 
and Motion JPEG.

Modify the settings for your graphics adapter. Please see the adapter's documentation 
for more information.

The test image does not display as expected.
Image settings. Not all settings have an effect on the test image. For more information, see the help on 

Image Settings. 

The Power indicator is not constantly lit
Faulty power supply. Check that you are using an AXIS PS-K power supply. 

The Status and Network indicator LEDs are flashing red rapidly
Hardware failure. Contact your Axis dealer. 

The Status indicator LED is flashing red and the camera is inaccessible
A firmware upgrade has been inter-
rupted or the firmware has otherwise 
been damaged.

See the Emergency Recovery Procedure above. 

Poor quality snapshot images
Screen incorrectly configured on your 
workstation.

In Display Properties, configure your screen to show at least 65000 colors, i.e. at least 
16-bit. Using only 16 or 256 colors will produce dithering artifacts in the image. 

Browser freezes
Netscape 7.x or Mozilla 1.4 (or later) 
can sometimes freeze on a slow com-
puter.

Lower the image resolution. 

Problems uploading files
Limited space. There is only limited space available for the upload of your own files. Try deleting one or 

more existing files, to free up space.

Missing images in uploads. This can occur when trying to use a larger image buffer than is actually available. Try 
lowering the frame rate or the upload period.

Overlay is not displayed
Incorrect size or location of overlay. The overlay may have been positioned incorrectly. Refer to the online help for informa-

tion on the limitations when using image overlays and privacy masks.

Motion Detection triggers unexpectedly
Changes in luminance. Motion detection is based upon changes in luminance in the image. This means that if 

there are sudden changes in the lighting, motion detection may be mistakenly triggered. 
Lower the sensitivity setting to avoid problems with luminance.

No audio
 Incorrect setup. Check that the sound card in the PC and the connections to the speaker and microphone 

are working. Ensure that the mute button is not pressed and the volume settings are cor-
rect. Ensure that full-duplex is selected if you want to have two way audio communica-
tion. 

Post Content Length in proxy server. The Post Content Length set in the proxy server is too low. Set the value of the Post Con-
tent Length in your proxy server to 1MB or more. You may need to contact your system 
administrator to do this.
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For additional assistance, please contact your reseller or see the support pages on the Axis 
Website at www.axis.com/techsup

Full duplex not supported. Sound card does not support full-duplex. For information on how to check if your sound 
card supports full-duplex, please visit http://support.microsoft.com

Firewall or router settings. The AXIS 210A/211A works locally, but not externally. Check the Internet firewall set-
tings with your system administrator or reconfigure the default router settings.

DC power not enabled for microphone. If the microphone has a built-in amplifier then the DC power must be enabled on the 
Audio Settings page.

Audio volume too low/high
Volume settings incorrect. The volume of the microphone or speaker connected to the AXIS 210A/211A is either too 

high or too low. Change the volume for the speaker or microphone in the Live View page. 

Input and output gain set incorrectly. Change the input gain for the microphone and the output gain for the speaker to adjust 
the audio levels on the Audio Settings page.

Poor audio quality
Too many users. Too many users/clients connecting to the AXIS 210A/211A may affect the sound quality 

adversely. Try limiting the number of clients allowed to connect on the Audio Settings 
page.

User too close to microphone. Enable the speech filter in Audio > Advanced Settings.
Feedback from speaker. Enable the echo cancellation filter in Audio > Advanced Settings.
Background noise. Adjust the noise cancellation threshold and attenuation to reduce background noise  

levels in Audio > Advanced Settings.
CPU overloaded. Reduce the number of listeners and viewers and decrease the image resolution and com-

pression.
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Active Speaker - a speaker with a built-in power amplifier.

ActiveX - A control (or set of rules) used by a browser. 
ActiveX controls are often downloaded and installed 
automatically as required.

ADPCM - Adaptive Differential Pulse Code Modulation. 
Predicts the analog signal digitally and the difference is 
coded.

AMC - AXIS Media Control. The control required for 
viewing video images in Internet Explorer for Windows. 
Installs automatically on first use.

API - Application Programming Interface. The Axis API can 
be used for integrating Axis products into other 
applications.

ARP - Address Resolution Protocol. A protocol for assigning 
an IP address to a physical device address that is recognized 
in the local network. The ARP command can be used to set 
the IP-address for your product.

ARTPEC - Axis Real Time Picture Encoder - used for video 
image compression.

CCD - Charge Coupled Device. CCD is one of the two main 
types of image sensors used in digital cameras. When a 
picture is taken, the CCD is struck by light coming through 
the camera’s lens. Each of the thousands or millions of tiny 
pixels that make up the CCD convert this light into 
electrons. 

CGI - Common Gateway Interface. A set of rules (or a 
program) that allows a Web Server to communicate with 
other programs.

Client/Server - Describes the network relationship between 
two computer programs in which one, the client, makes a 
service request from another - the server.

dB (Decibels) - A unit to measure sound level changes. A 
3dB change is the smallest level change we can hear. A 3dB 
change is actually twice or half the audio power level. A 
gain of 0dB leaves the signal level unchanged. 

DC-Iris - This special type of iris is electrically controlled 
by the Axis camera, to automatically regulate the amount of 
light allowed to enter.

DNS - The Domain Name System (DNS) locates and 
translates Internet domain names into IP (Internet Protocol) 
addresses.

Ethernet - A widely used networking standard.

ETRAX - Axis' own microprocessor.

Firewall - A virtual barrier between a LAN (Local Area 
Network) and other networks, e.g. the Internet.

FTP - File Transfer Protocol. Used for the simple transfer of 
files to and from an FTP-server.

Full duplex - Transmission of data, e.g. audio, in two 
directions simultaneously. 

G.711 - G.711 is the international standard for encoding 
telephone audio on 64 kBit/s channel. It is a pulse code 
modulation (PCM) scheme operating at 8 kHz sample rate. 

G.726 - Frequently used speech-compression algorithm in 
telecommunications due to its high perceived speech quality 
and low resource requirements. 

Half duplex- A half duplex link can communicate in only 
one direction, at a time. Two way communication is 
possible, but not simultaneously. Walkie-talkies and CB 
radios mimic this behavior in that you cannot hear the other 
person if you are talking. 

HTML - Hypertext Mark-up Language. Used widely for 
authoring documents viewed in web browsers.

HTTP - Hypertext Transfer Protocol. The set of rules for 
exchanging files (text, images, sound, video, and other files) 
on the World Wide Web.

HTTPS - Hypertext Transfer Protocol over Secure Socket 
Layer. A web protocol that provides encryption for page 
requests from users and for the pages returned by the web 
server.

Intranet - A private network limited to an organization or 
corporation. Usually closed to external traffic.

IP - Internet-Protocol. See TCP/IP.

IP address - A unique number used by a network device, to 
allow it to be identified and found on the network. The 
32-bit IP address is made up of four groups (or quads) of 
decimal digits separated by periods. An example of an IP 
address is: 192.168.0.1

ISMA - Internet Streaming Media Alliance

JPEG - A standard image format, used widely for 
photographs. Also known as JPG.

LAN - A local area network (LAN) is a group of computers 
and associated devices that typically share common 
resources within a limited geographical area.

Linux - A popular operating system, which is “open source” 
and practically free of charge.

Lux - A standard unit for the measurement of light, where 1 
Lux equals the light emitted from a single candle at a 
distance of one meter.

Mbit/s - Megabits per second. A unit for measuring speeds 
in networks. A LAN might run at 10 or 100 Mbit/s.

MPEG-4 - A standard video format, used for low bandwidth 
video streams. 

Multicast - The same information is sent only once and 
only to the intended recipients. 

NTSC - National Television Standards Committee. NTSC is 
the standard format used for televisions in most of North 
and Central America, and Japan. 

Glossary of Terms
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NWAY - A network protocol that automatically negotiates 
the highest possible common transmission speed between 
two devices.

PAL - Phase Altering Line. PAL is the standard format used 
for televisions in most of the world (other than the US, 
Canada, and Japan).

PCM - Pulse Code Modulation. Analog signal converted 
directly to a digital.

Ping - A small utility used for sending data packets to 
network resources to check that they are working and that 
the network is intact.

Pre/post alarm image - The images from immediately 
before and after an alarm.

Protocol - A special set of rules governing how two entities 
communicate. Protocols are found at many levels of 
communication, and there are hardware protocols and 
software protocols.

Router - A device that determines the next network point to 
which a packet should be forwarded on its way to its final 
destination. A router is often included as part of a network 
switch (see below).

RTP- Real-Time Transfer Protocol. A transfer protocol 
designed for delivery of live contents, e.g. MPEG-4.

Simplex - In simplex operation, a network cable or 
communications channel can only send information in one 
direction. 

SMTP - A common e-mail protocol.

SNMP - Simple Network Management Protocol. An 
application layer protocol that facilitates the exchange of 
management information between network devices. It is 
part of the Transmission Control Protocol/Internet Protocol 
(TCP/IP) protocol suite.

Subnet Mask - An IP address consists of two components: 
the network address and the host address. “Subnetting’ 
enables a network administrator to further divide the host 
part of the address into two or more subnets. The subnet 
mask identifies the subnet to which an IP address belongs. 

Switch - Whilst a simple hub transmits all data to all 
devices connected to it, a switch only transmits the data to 
the device it is specifically intended for. 

TCP/IP - Transmission Control Protocol/Internet Protocol. A 
suite of network protocols that determine how data is 
transmitted. TCP/IP is used on many networks, including the 
Internet. TCP keeps track of the individual packets of 
information and IP contains the rules for how the packets 
are actually sent and received. 

URL - Uniform Resource Locator. An “address" on the 
network.

Varifocal - A varifocal lens provides a wide range of focal 
lengths, as opposed to a lens with a fixed focal length, 
which only provides one.

WAN - Wide-Area-Network. Similar to a LAN, but on a 
larger geographical scale.

Web server - A program on a computer (server) providing 
the resources (e.g. web pages) requested by the user (client).
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